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MACSUITE FOR THE NOKIA 9110 AND 9110i COMMUNICATOR VER. 1.1

IMPORTANT: READ CAREFULLY BEFORE INSTALLING, DOWNLOADING, OR USING THE SOFTWARE

NOKIA MOBILE PHONES END-USER SOFTWARE AGREEMENT

This Software Agreement ("Agreement") is between You (either an individual or an entity), the End User, and
Nokia Mobile Phones Ltd. ("Nokia").  The Agreement authorizes You to use the Software specified in Clause 1
below, which may be stored on a CD-ROM, sent to You by electronic mail, or downloaded from Nokia’s Web
pages or Servers or from other sources under the terms and conditions set forth below. This is an agreement on
end-user rights and not an agreement for sale. Nokia continues to own the copy of the Software and the
physical media contained in the sales package and any other copy that You are authorized to make pursuant to
this Agreement.

Read this Agreement carefully before installing, downloading, or using the Software.  By clicking on the "I
Accept" button while installing, downloading, and/or using the Software, You agree to the terms and conditions
of this Agreement.  If You do not agree to all of the terms and conditions of this Agreement, promptly click the
"Decline" or "I Do Not Accept" button, cancel the installation or downloading, or destroy or return the Software
and accompanying documentation to Nokia. YOU AGREE THAT YOUR USE OF THE SOFTWARE ACKNOWLEDGES
THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS.

1. SOFTWARE.  As used in this Agreement, the term "Software" means, collectively: (i) the software product
identified above (ii) all the contents of the disk(s), CD-ROM(s), electronic mail and its file attachments, or other
media with which this Agreement is provided, including the object code form of the software delivered via a
CD-ROM, electronic mail, or Web page (iii) digital images, stock photographs, clip art, or other artistic works
("Stock Files") (iv) related explanatory written materials and any other possible documentation related thereto
("Documentation"); (v) fonts, and (vi) upgrades, modified versions, updates, additions, and copies of the
Software (collectively "Updates"), if any, licensed to You by Nokia under this Agreement.

2. END-USER RIGHTS AND USE. Nokia grants to You non-exclusive, non-transferable end-user rights to install
the Software on the local hard disk(s) or other permanent storage media of one computer and use the Software
on a single computer or terminal at a time.

3. LIMITATIONS ON END-USER RIGHTS.  You may not copy, distribute, or make derivative works of the Software
except as follows:

(a) You may make one copy of the Software on magnetic media as an archival backup copy, provided Your
archival backup copy is not installed or used on any computer. Any other copies You make of the Software are
in violation of this Agreement.

(b) You may not use, modify, translate, reproduce, or transfer the right to use the Software or copy the
Software except as expressly provided in this Agreement.

(c) You may not resell, sublicense, rent, lease, or lend the Software.

(d) You may not reverse engineer, reverse compile, disassemble, or otherwise attempt to discover the source
code of the Software (except to the extent that this restriction is expressly prohibited by law) or create
derivative works based on the Software.
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(e) Unless stated otherwise in the Documentation, You shall not display, modify, reproduce, or distribute any of
the Stock Files included with the Software. In the event that the Documentation allows You to display the
Stock Files, You shall not distribute the Stock Files on a stand-alone basis, i.e., in circumstances in which the
Stock Files constitute the primary value of the product being distributed. You should review the "Readme" files
associated with the Stock Files that You use to ascertain what rights You have with respect to such materials.
Stock Files may not be used in the production of libelous, defamatory, fraudulent, infringing, lewd, obscene, or
pornographic material or in any otherwise illegal manner. You may not register or claim any rights in the Stock
Files or derivative works thereof.

(f) You agree that You shall only use the Software in a manner that complies with all applicable laws in the
jurisdiction in which You use the Software, including, but not limited to, applicable restrictions concerning
copyright and other intellectual property rights.

4. COPYRIGHT.  The Software and all rights, without limitation including proprietary rights therein, are owned
by Nokia and/or its licensors and affiliates and are protected by international treaty provisions and all other
applicable national laws of the country in which it is being used. The structure, organization, and code of the
Software are the valuable trade secrets and confidential information of Nokia and/or its licensors and affiliates.
You must not copy the Software, except as set forth in clause 3 (Limitations On End-User Rights). Any copies
which You are permitted to make pursuant to this Agreement must contain the same copyright and other
proprietary notices that appear on the Software.

5. MULTIPLE ENVIRONMENT SOFTWARE / MULTIPLE LANGUAGE SOFTWARE / DUAL MEDIA SOFTWARE /
MULTIPLE COPIES / UPDATES. If the Software supports multiple platforms or languages, if You receive the
Software on multiple media, or if You otherwise receive multiple copies of the Software, the number of
computers on which all versions of the Software are installed shall be one computer. You may not rent, lease,
sublicense, lend, or transfer versions or copies of the Software You do not use. If the Software is an Update to a
previous version of the Software, You must possess valid end-user rights to such a previous version in order to
use the Update, and You may use the previous version for ninety (90) days after You receive the Update in order
to assist You in the transition to the Update. After such time You no longer have a right to use the previous
version, except for the sole purpose of enabling You to install the Update.

6. COMMENCEMENT & TERMINATION.  This Agreement is effective from the first date You install the Software.
You may terminate this Agreement at any time by permanently deleting, destroying, and returning, at Your own
costs, the Software, all backup copies, and all related materials provided by Nokia. Your end-user rights
automatically and immediately terminate without notice from Nokia if You fail to comply with any provision of
this Agreement. In such an event, You must immediately delete, destroy, or return at Your own cost, the
Software, all backup copies, and all related material to Nokia.

7. YOU ACKNOWLEDGE THAT THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW NEITHER NOKIA, ITS
LICENSORS OR AFFILIATES, NOR THE COPYRIGHT HOLDERS MAKE ANY REPRESENTATIONS OR WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR THAT THE SOFTWARE WILL NOT INFRINGE ANY THIRD PARTY PATENTS,
COPYRIGHTS, TRADEMARKS, OR OTHER RIGHTS.  THERE IS NO WARRANTY BY NOKIA OR BY ANY OTHER PARTY
THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE.  YOU ASSUME ALL RESPONSIBILITY
AND RISK FOR THE SELECTION OF THE SOFTWARE TO ACHIEVE YOUR INTENDED RESULTS AND FOR THE
INSTALLATION, USE, AND RESULTS OBTAINED FROM IT.

8. NO OTHER OBLIGATIONS.  This Agreement creates no obligations on the part of Nokia other than as
specifically set forth herein.
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9. LIMITATION OF LIABILITY.   TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
NOKIA, ITS EMPLOYEES OR LICENSORS OR AFFILIATES BE LIABLE FOR ANY LOST PROFITS, REVENUE, SALES,
DATA, OR COSTS OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, PROPERTY DAMAGE, PERSONAL
INJURY, INTERRUPTION OF BUSINESS, LOSS OF BUSINESS INFORMATION, OR FOR ANY SPECIAL, DIRECT,
INDIRECT, INCIDENTAL, ECONOMIC, COVER, PUNITIVE, SPECIAL, OR CONSEQUENTIAL DAMAGES, HOWEVER
CAUSED AND WHETHER ARISING UNDER CONTRACT, TORT, NEGLIGENCE, OR OTHER THEORY OF LIABILITY
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF NOKIA OR ITS LICENSORS OR
AFFILIATES ARE ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
COUNTRIES/STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF LIABILITY, BUT MAY ALLOW LIABILITY
TO BE LIMITED, IN SUCH CASES, NOKIA, ITS EMPLOYEES OR LICENSORS OR AFFILIATES' LIABILITY SHALL BE
LIMITED TO U.S. $50.
Nothing contained in this Agreement shall prejudice the statutory rights of any party dealing as a consumer.
Nothing contained in this Agreement limits Nokia's liability to You in the event of death or personal injury
resulting from Nokia's negligence. Nokia is acting on behalf of its employees and licensors or affiliates for the
purpose of disclaiming, excluding, and/or restricting obligations, warranties, and liability as provided in this
clause 9, but in no other respects and for no other purpose.

10. TECHNICAL SUPPORT.  Nokia has no obligation to furnish You with technical support unless separately
agreed in writing between You and Nokia.

11. EXPORT CONTROL. The Software, including technical data, includes cryptographic software subject to export
controls under the U.S. Export Administration Regulations ("EAR") and may be subject to import or export
controls in other countries. The EAR prohibits the use of the Software and technical data by a Government End
User, as defined hereafter, without a license from the U.S. government. A Government End User is defined in
Part 772 of the EAR as "any foreign central, regional, or local government department, agency, or other entity
performing governmental functions; including governmental research institutions, governmental corporations,
or their separate business units (as defined in part 772 of the EAR) which are engaged in the manufacture or
distribution of items or services controlled on the Wassenaar Munitions List, and international governmental
organizations. This term does not include: utilities (telecommunications companies and Internet service
providers; banks and financial institutions; transportation; broadcast or entertainment; educational
organizations; civil health and medical organizations; retail or wholesale firms; and manufacturing or industrial
entities not engaged in the manufacture or distribution of items or services controlled on the Wassenaar
Munitions List.)" You agree to strictly comply with all applicable import and export regulations and
acknowledge that You have the responsibility to obtain licenses to export, re-export, transfer, or import the
Software. You further represent that You are not a Government End User as defined above, and You will not
transfer the Software to any Government End User without a license.

12. NOTICES.  All notices and return of the Software and Documentation should be delivered to:

NOKIA MOBILE PHONES LTD.
P.O. Box 100
FIN-00045 NOKIA GROUP
FINLAND
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13.  APPLICABLE LAW & GENERAL PROVISIONS.

This Agreement is governed by the laws of Finland.  All disputes arising from or relating to this Agreement shall
be settled by a single arbitrator appointed by the Central Chamber of Commerce of Finland. The arbitration
procedure shall take place in Helsinki, Finland in the English language. If any part of this Agreement is found
void and unenforceable, it will not affect the validity of the balance of the Agreement, which shall remain valid
and enforceable according to its terms. This Agreement may only be modified in writing by an authorized
officer of Nokia.

This is the entire agreement between Nokia and You relating to the Software, and it supersedes any prior
representations, discussions, undertakings, end-user agreements, communications, or advertising relating to the
Software.

PLEASE SUBMIT ANY ACCOMPANYING REGISTRATION FORMS TO RECEIVE REGISTRATION BENEFITS WHERE
APPLICABLE.
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Startup

What is MacSuite?

With MacSuite you can manage data in your Nokia 9110 Communicator with a compatible
Macintosh® computer; you can for example:

•  Retrieve contacts data from the communicator, edit and update it.
•  Import data from or export data to other contact applications by using tab-

or comma- delimited text files.
•  Transfer received faxes and short messages from your communicator to

your desktop.
•  Transfer notes for a meeting to your communicator from your desktop.
•  Backup data from your communicator.
•  Install add-on software to your communicator.

System requirements

•  Apple Macintosh, with MacOS 7.5.3 or higher.
•  QuickTime® for handling images.
•  MacSuite requires 8 MB or more memory.
•  A standard Macintosh serial port with a null modem cable and adapter, or a

USB port with a serial converter.

Installing and starting MacSuite

1. Open the installation disk image, named MacSuite.smi, which you received
on the CD-ROM package (or downloaded from the Internet), by double-
clicking the icon. The opened distribution disk named MacSuite Folder can
then be found on the desktop.

2. Copy the MacSuite Folder to your hard drive: click and drag it to the
destination folder. Finder copies the contents to the location. Now you
have installed MacSuite. You can then remove the distribution disk image,
named MacSuite Folder, from your Desktop by dragging its icon to the
Trash.

Note: Do not send the folder you copied onto your hard drive to the trash.
Start the MacSuite by double-clicking the MacSuite icon in the MacSuite folder.
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Main window and menus

Everything in MacSuite is done within the main window. Switching between components changes the
contents and layout of the main window.

Components can be activated by pressing one of the component buttons on the left-hand side, or
selecting an item from the Components menu.

MacSuite’s component
buttons.

The name of the active
component



Nokia 9110 and 9110i Communicator
Version 1.1

Copyright � 2000 Nokia. All rights

MacSuite’s menu structure

 

These items can be used when the File Transfer
option is enabled.

If you have used NServer software for the Macintosh in
the past to export contacts, you can read the file into the
MacSuite’s contacts with this command.

Update the current contacts to the communicator, or get
the currently connected communicator's contacts and
update them to MacSuite’s contacts.
You can import/export contact data via comma- or tab-delimited
text files.
Editing commands.
Use this command if you want to find information in the
Contacts list.
 r

Edit the names of registered Communicators

Set MacSuite’s preferences.
Add a new contact or a contact group to MacSuite

Delete a selected contact or group
eserved.
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Add/remove fields of currently selected contact

Add/remove an image to/from a contact

Make the currently selected contact the pre-set
template for new contacts.
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Preferences

You can set MacSuite’s preferences in the Preferences dialogue box, which can be opened by selecting
Preferences from the Edit menu.

Registered Communicators

MacSuite identifies Communicators by a serial number (the IMEI number of the phone). MacSuite
allows you to assign a more readable name for your communicator.

When connecting a communicator for the very first time it is assigned with the default name “Nokia
9110”, and it is added to MacSuite’s Registered Communicators list. The name of the connected
communicator is shown in the bottom of the main window.

In the Registered Communicators list you can assign a name to the connected communicator.

Changing the communicator name

1. Open the Registered Communicators list by choosing the Registered Communicators command in
the Edit menu.

2. Choose the row you wish to edit and click the Edit-button, or double-click on the row. You cannot
edit the serial number of the communicator (which is the IMEI number of the phone).

Select the serial port to be used from this popup
menu. It shows all serial ports currently installed.

When using the File Transfer component, some
operations have safety warnings. They can be
overridden here.

When updating the communicator contacts, existing
data can be deleted before importing new data. If this
option is not checked, then the communicator tries to
match records and adds new contacts accordingly.

Select the font to be used when printing.
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3. The list can be transferred from MacSuite to a file, or read from a file, using the Import/Export
buttons.

4. To remove unwanted entries, select the row and click Remove.

Contacts

Contacts display

To activate the Contacts display, press the Contacts button on the component toolbar on the left-
hand side of the main window, or select Contacts in the Components menu.

The Tools menu is only activated when editing Contacts.

Creating a new contact

To create a new contact, click the New Contact button in the Contacts display or select it from the
Tools menu. A new contact, with default fields appears (the default field layout can be changed using
the Make Contact Card Template command – see below).

Editing contacts

To edit a contact in the contacts list, select it.

Buttons for quick editing of
contacts and contact groups.

Buttons for editing contact
images. A contact card must
be selected.

List of contacts and groups
in your communicator.

The contents of the selected
contact card are shown
here.
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Fields can be edited either by writing directly in the field or double-clicking them to bring up the Edit
Field dialogue box.

Address and Notes fields can only be edited in the Edit Field dialogue box, since they can include
several rows of data; when not in Edit Field dialogue, the Address and Notes data is visible on one row
(all the information has been saved).

You can delete the selected contact by choosing the Delete Contact button in the Contacts display or
by choosing the item from the Tools menu.

Editing contact groups

To create a new contact group, click the New Group button in the Contacts display or select it from
the Tools menu. A new group with a default name is created. To edit a group double-click it in the
contacts list, thus launching the Group Editor window.

 

Drag contacts from the contacts list (or from other group windows) to add them to a group.

You can delete the selected contact by choosing the Delete Group button in the Contacts display or by
choosing the item from the Tools menu.

Making a contact card template

A new contact card has a default field layout. This layout can be changed by selecting a contact in the
contacts list and then making its content the default layout, by selecting Make Contact Card
Template… .
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Updating contacts to/from the communicator

Remember to set in the Preferences window whether you want to replace existing contacts data when
updating to the communicator.

MacSuite always updates it's contact database when receiving contacts from the communicator.

You can empty MacSuite’s contact database by selecting all contacts and choosing the Delete
Selected button or the menu item from the Tools menu.

 If you have assigned contact images to cards and they exist in the communicator and/or MacSuite
they are also updated.

Updating from file

If you have used NServer for Macintosh in the past, and you have exported your contacts from the
communicator with it, you can update information from that file directly into MacSuite with Update
from File… command.

Importing/exporting text data

Import/Export can be found in the File menu. With Import/Export you can get tab- or comma-
delimited data from a text file to your contact database, or save to a similar file for updating to
another application.

You can export contacts from your communicator to a standard tab- or comma-delimited text file, for
importing them to third-party contacts management software or to the company’s internal database
(most database software supports tab- or comma-delimited text file formats).

You can also import contacts to your communicator from your company’s internal database or other
contact management software.

You can choose between Import to Communicator and Export from Communicator by choosing the
item in the popup menu in top of the window while in the Import/Export component.

Importing contacts directly to the communicator

You can save the current import configuration or use an existing one by using the Preset buttons.
Select the correct separator mark. Select the text file you wish to import. The imported file must be in
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the correct format. The contents of the current record in the text file are shown. You can browse the
contents of the selected file using the arrow buttons.

When fields have been selected click the Import button to proceed with importing data.

Exporting contacts from the communicator

When the fields have been selected click the Export button to proceed with Exporting data. Select a
row, then designate a field to the selected row using the Add field popup menu. To remove a row,
select the row and click the Remove Field button. You can save the current import configuration or
use an existing one by using the Preset buttons.

Select the right separator mark.
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File Transfer

File Transfer display

Transferring files from a Mac to the communicator

You can transfer files from your desktop to the communicator by dragging and dropping directly from
the Finder to MacSuite's folder view (or to the File Transfer button) or by clicking Copy from Mac
button in the File Transfer display.

MacSuite converts long file names to communicator's filename format. Text files are converted to the
correct character set. Text files cannot be converted back to short messages with  sender information
included.

To point to the location where you wish to transfer the file, first choose the destination folder in the
folder view, then transfer the file. If you have not selected the destination, MacSuite will suggest the
default destination folder for the filetype.

Conversions and file naming

If you transfer a communicator fax file to your desktop, the fax is converted to TIFF image file format;
the TIFF format used is a FAX-TIFF. This kind of TIFF file can be viewed with most Macintosh fax
applications or shareware utilities such as Tiff-Sight from Blue Globe Software
(http://www.blueglobe.com/).

Before transferring any faxes from the communicator to your Macintosh, make sure that none of the
fax files are open in the communicator. A fax cannot be transferred while it is in use.

If you are transferring a TIFF file to the Received Faxes folder in your communicator, the
communicator attempts to convert the file to it's fax file format. If this is not possible (e.g. if the file
format is incompatible), then the file is transferred as it is.

When transferring text documents from the communicator (Received messages, Own texts, Calendar
memos), they are converted to standard  Macintosh text file format.

List of files and folders in
the communicator.

Command buttons.

http://www.blueglobe.com/
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When transferring a file from the desktop to the communicator,  the name of the file must be
changed to an MS-DOS format file name with a maximum of 8 characters in the file name and a
maximum of 3 characters in the extension. This is because the communicator does not allow longer
names on foreign files (internal messages and notes texts can have longer names).

Transferring files from the communicator to a Mac

To transfer a file from the communicator to the desktop, select the item from the folder view, click the
Copy to Mac button and assign the destination and a name for the transferred file.

Bypassing the text conversion

When text files are transferred to/from the communicator, by default MacSuite converts these files to
a suitable format.  For example, short messages transferred from the communicator to a Mac are
converted to Macintosh format and character set, and files being transferred from a Mac to the
communicator are converted to the communicator character set.

In occasions when you do not want your files to be converted while transferred, when for example,
you are using your communicator as a temporary storage for encrypted text files, you can bypass the
conversion by holding down the  Command-key while clicking or choosing the Copy to Mac or Copy
from Mac-command.

Creating folders

Select the destination for the new folder in the folder view. Click the New Folder…  button or select
New Folder from the File menu. A new “Untitled folder” is created in the communicator. You may
rename it with the name you want.

Renaming files and folders

Select a file or folder to be renamed and click the Rename button or select the Rename command
from the File menu. For files that already have an MS-DOS-type filename (8+3 characters) the new
file name must also be in MS-DOS-filename format.

Example of using File Transfer: Sending an SMS

MacSuite cannot instruct the communicator to send short messages for you, but you can transfer a
text file to any folder in your communicatorand use the communicator’s own functionalities to send
the text as an SMS (or e-mail or fax it). The communicator supports smart messaging and long
messages, so your SMS can be fairly long.
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Backup and restore

Making a backup

First select what to backup: To backup all data (including the memory card, if installed), select All
device data. If you want to adjust the backup set, use Selected device data. Select the folder where
the new backup set will be stored (this, too, will be a folder).

Backup sets in the selected folder are shown in the list. To manage the amount of backup sets, simply
open the backup folder in Finder and delete any backup sets no longer needed.

1. Select the destination folder for backup files.

2. Choose what you wish to backup from your communicator.

3. Click the Backup button to start the process.
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Restoring a backup

1. Select the folder which has the backup set that you wish to restore.

2. The list of restorable sets is shown.

3. Choose the set you wish to restore.

4. Click the Restore button to start the process.

Backup sets found in the
backup folder.

Select the folder that contains
the Backup folder. This is the
folder you chose when selecting
the destination for the backup.
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Installing and removing software

You can install new software applications on your communicator. Such applications exist on the Nokia
9110 Communicator CD-ROM that came with your communicator, or you can purchase custom
applications from third-party developers. See more information about this option in the Nokia 9110
Communicator User’s Guide.

To install or remove software with MacSuite the Install/Remove component must be selected (choose
Install/Remove from the Components menu, or click the button in the Components toolbar).

Choose between installing new software and removing existing software from the popup menu in the
top of the window.

Install software on the communicator

1. Select the folder where the installable software resides. This type of folder usually consists of one
or more files, the name of which ends with a .ins or a .geo extension.

2. The installable applications in the selected folder can be seen in the list.

3. Select the application you wish to install.

4. Select the destination for  the new software application. You can install it into the
communicator’s own memory, or to a memory card if one is installed in your communicator.

5. Click Install to install the software.

Remove installed software from the communicator

When you select the Remove option from the popup menu, MacSuite searches the connected
communicator for user-installed software, and displays them in the list.

Choose between Install and Remove using the
popup menu.

Choose the destination for the new
software: communicator’s own
memory, or the memory card. The
memory card option is available
only if a memory card is installed
in your communicator.

Select the folder where the
installable software resides.

List of installable software in
the selected folder.
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To remove software:

1. Select the software you wish to remove from the communicator

2. Click Remove.

List of user-installed
applications in your
communicator. The icon
indicates if the software exists
in the communicator’s
memory or on a memory card.
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Appendixes

A: Serial cables and USB converters

When connecting your communicator to a compatible Macintosh® computer you always need the
serial cable that came with your communicator. It has a standard 9-pin serial connector on one end,
and the other end is inserted at the bottom of your communicator. This procedure is described in more
detail in the communicator’s manual.

Standard Mac serial port

If your Macintosh has a standard Mac serial port (a round mini-DIN8 connector), usually marked with
a small icon of a telephone or printer, then connect the communicator to your Mac using the data
cable. You also need a standard Macintosh modem cable and a 25-pin (female) to 9-pin (male)
converter. Just connect the cables with the converter.

USB

If your Macintosh has only a USB port, you need a USB to serial port converter. There are two kinds of
Mac-compatible USB serial converters:

If your USB to serial port converter has a standard Macintosh serial port, you also need a Mac modem
cable and a 25-pin (female) to 9-pin (male) converter (the same situation as described above), which
then connects to the communicator serial cable.

If your USB to serial port converter already has a 9-pin (male) connector, simply plug your
communicator serial cable directly into it.

Note: Remember to use the latest drivers for your converter and make sure that your MacOS is
running with the latest USB driver updates.
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Select a serial port

After you have connected your communicator to a Mac, set the MacSuite to use the correct serial
port. Use the Preferences dialogue (select Preferences from the Edit menu).
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B: Basic troubleshooting

Installation

Could not copy Make sure you have enough free diskspace on your destination
hard disk. MacSuite Folder takes about 5 megabytes of free space.

What is QuickTime? QuickTime is a free multimedia viewer extension from Apple. It is
usually installed  automatically with newer MacOS versions, but
you can also download it directly from Apple.

See http://www.apple.com/quicktime

Connecting

Port in use The serial port you have chosen in the Preferences is currently
being used by another application. Examine your settings, check
that the correct serial port is selected and check your AppleTalk
preferences in the Control Panels.

Could not establish a connection MacSuite was not able to connect to the communicator. Check
your connection cables and ensure that the correct serial port is
selected in the Preferences.

File Transfer

Cannot transfer a fax Check that the fax you are about to transfer is not in use or open
in the communicator. This prevents the communicator from
sending the file.

It is also good practise to do this with all big files, such as images.
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GENERAL LEGAL NOTICE

Copyright © Nokia Mobile Phones 2000. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form without the prior
written permission of Nokia is prohibited.

Nokia and Nokia Connecting People are registered trademarks of Nokia Corporation. Other product and company names
mentioned herein may be trademarks or tradenames of their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and improvements to any of
the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental, consequential
or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of any kind, either
express or implied, including, but not limited to, the implied warranties of merchantability and fitness for a particular
purpose, are made in relation to the accuracy, reliability or contents of this document. Nokia reserves the right to revise
this document or withdraw it at any time without prior notice.

The availability of particular accessories may vary by region. Please check with the Nokia dealer nearest to you.
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